Extended Data Analysis
Welcome

Features

Definition of Terms

License

Features

Ease of Use
  - EDA is easy to use. You can quickly create multiple reports and views.

Hardware Independent
  - Because EDA operates on data created by hardware manufacturer's software, not on the hardware itself, you do not need access to the hardware while running EDA.

Data stored in a database, not a flat file.

Access to multiple datasets for report generation
  - You can plot yesterday's data against today's to see what changed

Any set of data points can be plotted against any other set.
  - Interested in plotting RPM verses Speed? You can do it. And since the vertical series data is sorted in horizontal series order, the plots are meaningful.

Visual Session Editing

Visual Data Preview on Import

Selectable Smoothing for all data

User Defined Calculations

Session Descriptions stored with session data

Demo Data Base

Demo Data Base

A demonstration data base is included with the program. It is installed at:

<My Documents>\EDA\Databases\Demo.mdf

Definition of Terms

Definitions

Model - This is the model name used to identify the model to the Eagle Tree Data Recorder program.
Session - A logical grouping of series data points. There may be many sessions in an Eagle Tree data file, or only one.
Series - A logical grouping data points related to one measurement, i.e., Altitude or RPM
Import - the process of storing Eagle Tree data in a database

License

EULA stands for End User Licensing Agreement. This is the agreement through which the software is licensed to you, the software user.

**EXTENDED DATA ANALYSIS or EDA** ("SOFTWARE PRODUCT") is NOT freeware. You may use this software for a testing period of 30 days. Following this test period of 30 days or less, if you wish to continue to use SOFTWARE PRODUCT, you MUST purchase a license.

**EULA**

END-USER LICENSE AGREEMENT FOR **EXTENDED DATA ANALYSIS or EDA**

IMPORTANT PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE CONTINUING WITH THIS PROGRAM INSTALL:

**HOME TECHNOLOGY SERVICES** End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and **HOME TECHNOLOGY SERVICES** for the **HOME TECHNOLOGY SERVICES** software product(s) identified above which may include associated software components, media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT"). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. This license agreement represents the entire agreement concerning the program between you and **HOME TECHNOLOGY SERVICES**, (referred to as "licenser"), and it supersedes any prior proposal, representation, or understanding between the parties. If you do not agree to the terms of this EULA, do not install or use the SOFTWARE PRODUCT.

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1. GRANT OF LICENSE.
The SOFTWARE PRODUCT is licensed as follows:
(a) Installation and Use.
**HOME TECHNOLOGY SERVICES** grants you the right to install and use THREE copies of the SOFTWARE PRODUCT on computers owned by a single individual or entity, running a validly licensed copy of the operating system for which the SOFTWARE PRODUCT was designed [Windows 2003, Windows XP, and Windows Vista].
(b) Backup Copies.
You may also make copies of the SOFTWARE PRODUCT as may be necessary for backup and archival purposes.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.
(a) Maintenance of Copyright Notices.
You must not remove or alter any copyright notices on any and all copies of the SOFTWARE PRODUCT.
(b) Distribution.
You may not distribute registered copies of the SOFTWARE PRODUCT to third parties. Evaluation versions available for download from **HOME TECHNOLOGY SERVICES** websites may be freely distributed.
(c) Prohibition on Reverse Engineering, Decompilation, and Disassembly.
You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.
(d) Rental.
You may not rent, lease, or lend the SOFTWARE PRODUCT.
(e) Support Services.

HOME TECHNOLOGY SERVICES may provide you with support services related to the SOFTWARE PRODUCT ("Support Services"). Any supplemental software code provided to you as part of the Support Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and conditions of this EULA.

(f) Compliance with Applicable Laws.
You must comply with all applicable laws regarding use of the SOFTWARE PRODUCT.

3. TERMINATION
Without prejudice to any other rights, HOME TECHNOLOGY SERVICES may terminate this EULA if you fail to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE PRODUCT in your possession.

4. COPYRIGHT
All title, including but not limited to copyrights, in and to the SOFTWARE PRODUCT and any copies thereof are owned by HOME TECHNOLOGY SERVICES or its suppliers. All title and intellectual property rights in and to the content which may be accessed through use of the SOFTWARE PRODUCT is the property of the respective content owner and may be protected by applicable copyright or other intellectual property laws and treaties. This EULA grants you no rights to use such content. All rights not expressly granted are reserved by HOME TECHNOLOGY SERVICES.

5. NO WARRANTIES
HOME TECHNOLOGY SERVICES expressly disclaims any warranty for the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is provided As Is without any express or implied warranty of any kind, including but not limited to any warranties of merchantability, noninfringement, or fitness of a particular purpose. HOME TECHNOLOGY SERVICES does not warrant or assume responsibility for the accuracy or completeness of any information, text, graphics, links or other items contained within the SOFTWARE PRODUCT. HOME TECHNOLOGY SERVICES further expressly disclaims any warranty or representation to Authorized Users or to any third party.

6. LIMITATION OF LIABILITY
In no event shall HOME TECHNOLOGY SERVICES be liable for any damages (including, without limitation, lost profits, business interruption, or lost information) rising out of Authorized Users' use of or inability to use the SOFTWARE PRODUCT, even if HOME TECHNOLOGY SERVICES has been advised of the possibility of such damages. In no event will HOME TECHNOLOGY SERVICES be liable for loss of data or for indirect, special, incidental, consequential (including lost profit), or other damages based in contract, tort or otherwise. HOME TECHNOLOGY SERVICES shall have no liability with respect to the content of the SOFTWARE PRODUCT or any part thereof, including but not limited to errors or omissions contained therein, libel, infringements of rights of publicity, privacy, trademark rights, business interruption, personal injury, and loss of privacy, moral rights or the disclosure of confidential information.
Before You Begin

Starting EDA

Getting Help

System Requirements

Starting EDA

To start Extended Data Analysis:

Double click the "Extended Data Analysis" icon on your desktop.

OR

From the Start menu, select Programs, then Extended Data Analysis and click Extended Data Analysis.

Getting Help

Access the help file from the program:

- From the Help menu, click Help or press F1.

On-line resources:
- EDA Home Page

System Requirements

 Hardware

The minimum hardware requirements are:

- CPU: Pentium class processor (256MHz or higher)
  1 Ghz or better recommended
- Memory: 256MB or greater
  1 Gbyte or better recommended
- Disk Space: 10MB

Software
The minimum software requirements are:

- Operating system: Windows 2000 or higher
  
  Window XP or later recommended

- MS SQL Server 2005 Express Edition
Getting Started

Create a DataBase

Import Data

Design a Report

Create a Report List

Run Reports

Attach Demo Data Base

Open the Demo Data Base

Before you can use the Demo Data Base, you must open it.

To attach the Demo Data Base, from the Menu Bar, choose File
  ○ Open
  You will be asked to specify a file name (Demo).

Once you have opened the database, other options on the menu bar will become available.
Create a Database

Databases are created from the "File" menu.

From the Menu Bar, choose
  File
    Create

You will be asked to specify a file name.

Once you have created a database, other options on the menu bar will become available.
Once a Database has been created, data must be added to it. Current versions of the Eagle Tree Flight Data Recorder, Boat Data Recorder, Car Data Recorder, and Live Mode files are supported. From the Menu Bar, choose

File
  o Import

You will be asked to specify a file name.
You will be asked to add a description to the Model Name found in the Eagle Tree file

None of the model descriptive fields need to be filled in at this time. They can be edited later.
You will be asked for an Engine selection.
You can turn off Multi-Engine Dialogs by un-checking the Enable Multi-Engine Support Box
You will be asked to name or discard sessions in the Eagle Tree file. Discard a session by leaving the Name field blank.
Session Descriptions are copied from the appropriate Model Descriptions. None of the fields need to be filled in at this time. They can be edited later.

Importing Data can take significant time. CPU type, load, speed, and available memory affect processing the data. Pauses may be seen on the progress bar. They are normal.
## Model Description

### Model Type
- **Airplane - Electric**

### Preview Report List
- Preview-KOS_Port

### Cells
- **Name**
- **Capacity**
- **Weight**
- **Pack Configuration**

### Propeller
- **Name**
- **Diameter**
- **Pitch**

### Motor
- **Name**
- **Weight**
- **Poles**
- **KV**
- **Configuration**

### Speed Control
- **Name**
- **Weight**
- **Maximum Current**

### Drive
- **Name**
- **Gear Ratio**

### Airframe
- **Name**
- **Wing Span**
- **Wing Area**
- **Fuselage Length**
- **CG Position**
- **RTG* Weight**
  *RTG = Ready To Go

### Comments

### Multi-Engine Selections

#### Multi-Engine Support
- **Enable Multi-Engine Support**

#### Engine Selection
- **Engine 1**
- **Engine 2**
- **Engine 3**
- **Engine 4**

### OK Cancel
<table>
<thead>
<tr>
<th>Model Description</th>
<th>King of Shavas</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Type</td>
<td>Airplane - Electric</td>
</tr>
<tr>
<td>Preview Report List</td>
<td>Preview-KOS_Port</td>
</tr>
<tr>
<td>Session Description</td>
<td>kcs_port_20100527 9/27/2010 11:14:24 PM Session 1</td>
</tr>
<tr>
<td>Session Date</td>
<td>9/27/2010</td>
</tr>
<tr>
<td>Session Time</td>
<td>11:14:24pm</td>
</tr>
<tr>
<td>Cells</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Capacity</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td></td>
</tr>
<tr>
<td>Pack Configuration</td>
<td></td>
</tr>
<tr>
<td>Motor</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td></td>
</tr>
<tr>
<td>Poles</td>
<td></td>
</tr>
<tr>
<td>KV</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>Speed Control</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Weight</td>
<td></td>
</tr>
<tr>
<td>Maximum Current</td>
<td></td>
</tr>
<tr>
<td>Propellor</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Diameter</td>
<td></td>
</tr>
<tr>
<td>Pitch</td>
<td></td>
</tr>
<tr>
<td>Drive</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Gear Ratio</td>
<td></td>
</tr>
<tr>
<td>Airframe</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Wing Span</td>
<td></td>
</tr>
<tr>
<td>Wing Area</td>
<td></td>
</tr>
<tr>
<td>Fuselage Length</td>
<td></td>
</tr>
<tr>
<td>CG Position</td>
<td></td>
</tr>
<tr>
<td>RTG* Weight</td>
<td></td>
</tr>
<tr>
<td>*RTG = Ready To Go</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>Test Description</td>
</tr>
</tbody>
</table>
Design a Report

The Report Designer is the core of the Extended Data Analysis Application. This is where reports are created and modified.

From the Menu Bar, choose Report Designer
   - New Report

You can now design your report. The names and available data series are presented on the left side of the screen. As you select models, the sessions available in the database for that model will populate the session window. You may plot any number of sessions together.

You can select any number of series to plot on the left and right vertical axes, you may select only one series to plot on either or both the top or bottom horizontal axis.

While you are designing a report, use the Plot Preview button on the menu bar to preview your work.

When you have a report you like, save your work with the Save Report selection on the menu bar.

Optionally, you can adjust time to plot as seconds or minutes (default is milliseconds)
Create a Report List

This step is optional, since individual and multiple reports can be run from the “Run Reports” menu. However, it is sometimes easier to run a series of reports with one click, so individual reports can be grouped together in a report list.

From the Menu Bar, choose
  Report Designer
    • Manage Report Lists
To create a Report List, select reports from the "Reports" box to include in the new Report List, and select "Save".

To edit a Report List, select the report list from the "Report Lists" box, then modify the selections in the "Reports" box, and select "Save".
Run Reports

Once reports and (optionally) report lists have been created, they can be run from the "Run Reports" menu item.

From the Menu Bar, choose

Run Reports

- You will be asked to select the reports and/or report lists you want to run.
- Each report will be shown in its own window. Navigate between windows to view reports.
- Any report may be printed or output to a graphics file. You can also print or output all reports with a single selection from the menu bar.

PLEASE BE AWARE: Printing and writing graphics files is a long process, even on a fast computer. Be patient, the job will finish.
### Reports

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My First Report</td>
<td>My First Sample Report of Altitude &amp; Spe</td>
</tr>
<tr>
<td>My Second Report</td>
<td>My Second Sample Report of Motors Ampi</td>
</tr>
<tr>
<td>Ultra25 Overview</td>
<td>Overview for Imports</td>
</tr>
</tbody>
</table>

### Report Lists

<table>
<thead>
<tr>
<th>Report List Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Sample Report List</td>
<td>This lists the First and Second Sample Report</td>
</tr>
<tr>
<td>Preview Ultra25E</td>
<td>Import Preview for Ultra25e</td>
</tr>
</tbody>
</table>

Hold the CTRL key to select multiple items.

- Amps1: [Ultra35E Ultra25_jun20a 6/20/2007 7:14:20 PM Session 1]
- Amps2: [Ultra35E Ultra25_jul31a 7/14/2007 8:03:22 AM Session 1]
- PdzVolts: [Ultra35E Ultra25_jul31a 7/14/2007 8:03:22 AM Session 1]
Model & Session Descriptions

Model and Session Descriptions provide a convenient place to store important information about a model and the data sessions associated with it.

Model and Session Descriptions can be entered when they are first used, and edited later from the Edit menu.

Important Features of Model Descriptions:

- The Preview Report List field specifies a report list used to preview imported data.
- The information stored in a Model Description is used to fill in the default Session Description every time a session is imported.
- A change to a Model Description applies only to sessions imported after the change is made. This behavior can be over-ridden by checking the Apply Model changes to all sessions. Changes to Session Description fields will only be made if the session data field was copied from the corresponding Model Description field. For example:
  - You burn out a motor in your model and replace it. This is a change that applies to new imports only.
  - You fill in fields you didn't know the answers to when you created the model description. These changes apply to both old and new sessions, so you check the Apply Model changes to all sessions box.

Important Features of Session Descriptions:

- Session Descriptions store useful information about individual data sessions
- The program will suggest a description based on the filename and date the file was saved by the Eagle Tree application. It may be edited.
- Session Descriptions should be used to hold information that can vary from session to session
  - You are doing prop tests. You can record the prop diameter and pitch in the appropriate fields.
Series Editing

Session Editing

Sessions can be copied and deleted from the edit menu.

Making a copy of a session before editing it is highly recommended.
Sessions can also be edited visually on a plot.

Visual editing is guided by helpful prompts. Remember, reorganizing data in a data base takes time, so please be patient.

Advanced Report Design

With respect to the figure below:

Models:
- Multiple Models can be selected.
Sessions
  o Multiple Sessions can be selected.
  o <Ask> means ask for the sessions to be plotted at run time, not design time. One or more sessions should be selected so "Plot Preview" has something to show, but those selections will be ignored at run time.
  o Checking "Auto Add New Sessions" will automatically add new sessions for the selected model(s) to the report.

Series Names
  o Series names come from several sources:
    § Eagle Tree Data file Column names
    § Internal Calculations. These series names begin with "c_"
    § User Defined Calculations. These series names begin with "u_"

Vertical Axes
  o There are four vertical axes. Any number of series can be plotted on each one.
  o Click on a series to add it to a plot.
  o Right click a series to select additional options, like Smooth

Other Options
  o Time
    The default unit of time is milliseconds
    Time can be shown in seconds by checking Display Time in Seconds
    Time can be shown in minutes by checking Display Time in Minutes
    Time can be displayed relative to zero (removes any starting offset) by checking Zero Base Session Times
  o Plot Legends
    Session Descriptions can be included in plot by checking Legend Contains Session Descriptions
    Series Descriptions can be included in plot by checking Legend Contains Session Descriptions
Model Specific Series Descriptions

Model Specific Series/Sensor Descriptions

Series are named by the sensor they hold data for. While the series names are descriptive, they are generic, as are their descriptions. Often, it is clearer to name the sensors with respect to the model.

- For example
  - **Battery Temperature** instead of **Temperature 1**

From the Menu Bar, choose
Edit
- **Edit Model Specific Series Descriptions**
  You will be asked to specify a Model and Series/Sensor
  You will be asked for a new description
### User Defined Calculations

The image shows a user interface for Extended Data Analysis with a focus on User Defined Calculations. The interface includes options for editing model-specific series descriptions, such as:

- Edit Model Descriptions
- Edit Session Descriptions
- Edit User Defined Calculators
- Copy Session
- Delete Model
- Delete Session

The interface also displays a table for models and series, with columns for Model Name and Description. For example:

<table>
<thead>
<tr>
<th>Model Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ultra25E</td>
<td>Thrust Cell Test Airplane</td>
</tr>
</tbody>
</table>

Additionally, there is a dialog box titled "Ultra25E Specific Series Definition" that prompts to enter a short description for series Temp1 with options like:

- Battery Temperature
- Spectrum
- Spectrometer
- Spectrometer Left
- Spectrometer Right
- Temp1
- Temp2
- Thermo A
- Thermo B
- Thermo C
- Thermo D
- Thermo E
- Thermo F
- Throttle

This interface is designed to help users define and manage specific series descriptions for their models and experiments efficiently.